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INFORMATION MANAGEMENT AND 
SYNCHRONOUS COMMUNICATIONS 

SYSTEM WITH MENU GENERATION, AND 
HANDWRITING AND VOICE 
MODIFICATION OF ORDERS 

The present application is a continuation of application Ser. 
No. 10/016,517, filed Nov. 1, 2001 now U.S. Pat. No. 6,982, 
733, which is a continuation-in-part of application Ser. No. 
09/400,413, filed Sep. 21, 1999 (now U.S. Pat. No. 6,384, 
850). The contents of application Ser. No. 10/016,517 and 
application Ser. No. 09/400,413 are incorporated herein by 
reference. 

FIELD OF THE INVENTION 

This invention relates to an information management and 
synchronous communications system and method for genera
tion of computerized menus for restaurants and other appli
cations with specialized display and synchronous communi
cations requirements related to, for example, the use of 
equipment or software with non-PC-standard graphical for
mats, display sizes and/or applications for use in remote data 
entry, information management and synchronous communi
cation between host computer, digital input device or remote 
pager via standard hardwired connection, the internet, a wire
less link, smart phone or the like. 

BACKGROUND OF THE INVENTION 

While computers have dramatically altered many aspects 
of modern life, pen and paper have prevailed in the hospitality 
industry, e.g., for restaurant ordering, reservations and wait
list management, because of their simplicity, ease of training 
and operational speed. For example, ordering prepared foods 
has historically been done verbally, either directly to a waiter 
or over the telephone, whereupon the placed order is recorded 
on paper by the recipient or instantly filled. 

2 
compromises which in the aggregate have resulted in limited 
acceptance of PDA type devices in the restaurant and hospi
tality fields. 

Many of the negatives prevalent in earlier devices have 
been eliminated, but, to date, there is still no integrated solu
tion to the ordering/waitlist/reservation problem discussed 
above. With the advent of the Palm® and other handheld 
wireless devices, however, the efforts to make such devices 
ubiquitous have begun to bear fruit at least in some areas, e.g., 

10 personal calendars. However, substantial use of such devices 
in the restaurant and hospitality context has not occurred to 
date. As discussed above, at least one of the reasons PDAs 
have not been quickly assimilated into the restaurant and 
hospitality industries is that their small display sizes are not 

15 readily amenable to display of menus as they are commonly 
printed on paper or displayed on, e.g., large, color desktop 
computer screens. Another reason is that software for fully 
realizing the potential for wireless handheld computing 
devices has not previously been available. Such features 

20 would include fast and automatic synchronization between a 
central database and multiple handheld devices, synchroni
zation and communication between a World Wide Web 
("Web") server and multiple handheld devices, a well-defined 
application program interface ("API") that enables third par-

25 ties such as point of sale ("POS") companies, affinity pro
gram companies and internet content providers to fully inte
grate with computerized hospitality applications, real-time 
communication over the internet with direct connections or 
regular modem dialup connections and support for batch 

30 processing that can be done periodically throughout the day 
to keep multiple sites in synch with the central database. A 
single point of entry for all hospitality applications to com
municate with one another wirelessly has also previously 
been unavailable. Such a single point of entry would work to 

35 keep all wireless handheld devices and linked Web sites in 
synch with the backoffice server (central database) so that the 
different components are in equilibrium at any given time and 
an overall consistency is achieved. For example, a reservation 
made online would be automatically communicated to the 

40 backoffice server and then synchronized with all the wireless 
handheld devices wirelessly. Similarly, changes made on any 
of the wireless handheld devices would be reflected instanta
neously on the backoffice server, Web pages and the other 

Although not previously adapted for wide-scale use in the 
hospitality industry, various forms of digital wireless com
munication devices are in common use, e.g., digital wireless 
messengers and pagers. Also in common use are portable 
laptop and handheld devices. However, user-friendly infor- 45 
mation management and communication capability not 
requiring extensive computer expertise has not heretofore 
been available for use in everyday life such as for restaurant 
ordering, reservations and wait-list management. Hundreds 

handheld devices. 
For the foregoing reasons, paper-based ordering, waitlist 

and reservations management have persisted in the face of 
widespread computerization in practically all areas of com
merce. At most, computerization of these functions has been 
largely limited to fixed computer solutions, i.e., desktop or 
mainframe, because of the problems heretofore faced in con
figuring wireless handheld devices and maintaining database 

of millions of dollars have been spent on personal digital 50 

assistant ("PDA") development seeking to produce a small, 
light-weight and inexpensive device that could be adapted to 
such uses; yet none have yielded a satisfactory solution. 

One ofthe inherent shortcomings ofPDA type devices is 
that, as they strive for small size, low weight and low cost, 55 

they must compromise the size and clarity of the operator 
display medium interface itself, which in most cases is one of 
a variety of LCD (liquid crystal display) type devices. As the 
size of the display shrinks, the amount of information that 
may be displayed at any one point or time is commensurately 60 

decreased, typically requiring multiple screens and displays 
to display information to the operator. This reduces the over-
all utility of the device. Additionally, the smaller display and 
keyboard results in a non-optimal operator interface, which 
slows down operation and is thus unacceptable for the time 65 

criticality of ordering, reservation and wait-list management 
and other similar applications. This necessitates many design 

synchronization for such applications. Specifically, the 
unavailability of any simple technique for creating restaurant 
menus and the like for use in a limited display area wireless 
handheld device or that is compatible with ordering over the 
internet has prevented widespread adoption of computeriza-
tion in the hospitality industry. Without a viable solution for 
this problem, organizations have not made the efforts or 
investments to establish automated interfaces to handheld and 
Web site menus and ordering options. 

A principal object of the present invention is to provide an 
improved information management and synchronous com
munications system and method which facilitates user
friendly and efficient generation of computerized menus for 
restaurants and other applications that utilize equipment with 
non-PC-standard graphical formats, display sizes and/or 
applications. 
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A further object of the present invention is to provide an 
improved information management and synchronous com
munications system and method which provides for entry, 
management and communication of information from the 
operator as well as to and from another computer, Web page 
menu, remote digital device using a standard hardwired con
nection, the internet or a wireless link. 

A further object of the present invention is to provide an 
improved information management and synchronous com
munications system which is small, affordable and light- 10 

weight yet incorporates a user-friendly operator interface and 
displays menus in a readily comprehensible format. 

A further object of the present invention is to provide a 
synchronous information management and communications 
system which enables automatic updating of both wireless 15 

and internet menu systems when a new menu item is added, 
modified or deleted from any element of the system. 

SUMMARY OF THE INVENTION 

4 
(POS) system, printer or/or display system. This unique 
operator interface enables universal languages and an unlim
ited set of information to be manually communicated and 
exchanged. The resultant combined message of one or more 
fixed indications selected from a menu of a device such as a 
hand-held, and dynamic handwritten messages and/or data 
provides an even more powerful tool than either modality 
used independently. 

For example a restaurant server taking a drink order could 
select from a menu of her hand-held device's screen "Iced 
Tea", and then manually write in the literal screen of her 
hand-held "with lemon" as shown in FIG. 8. The manually
written information could, for example, be printed or dis-
played in front of a bartender preparing the drink order. The 
indication "Iced Tea" as selected from a menu of the hand
held would also be presented to the bartender, perhaps by 
printing and/or screen display. The server can also select any 
printer from within the hospitality establishment directly 

The foregoing and other objects of the present invention are 
provided by a synchronous information management and 
communications system and method optimized for simplicity 

20 from the operator interface on the screen of the hand-held and 
have either the order or the receipt printed out where it is most 
convenient and efficient. 

of operation which incorporates menu generation for creation 
of menus to be used with wireless remote handheld computer 
and PDA devices, the internet or any application where 
simple and efficient generation of menus is appropriate. The 
menu generation approach of the present invention includes a 
desktop software application that enables the rapid creation 
and building of a menu and provides a means to instantly 
download the menu configuration onto, e.g., a handheld 
device or Web page and to seamlessly interface with standard 
point of sale ("POS") systems to enable automatic database 
updates and communication exchanges when a change or 
input occurs in any of the other system elements. To solve the 
above and other related problems, an information manage
ment and communications system is provided which results 
in a dramatic reduction in the amount of time, and hence cost, 
to generate and maintain computerized menus for, e.g., res
taurants and other related applications that utilize non-PC
standard graphical formats, display sizes or applications. 

The menu generation approach of the present invention has 
many advantages over previous approaches in solving the 
problem of converting paper-based menus or Windows® PC
based menu screens to small PDA-sized displays and Web 
pages. In one embodiment, the present invention is a software 
tool for building a menu, optimizing the process of how the 
menu can be downloaded to either a handheld device or Web 
page, and making manual or automatic modifications to the 
menu after initial creation. 

Similarly, a server taking a drink order could select from a 
menu of her hand-held device's screen "Iced Tea", and then 

25 record the voice message "with lemon" using her hand-held 
device integral microphone. The recorded information could, 
for example, be played on a speaker attached to a computer, 
POS system, or the like located near the bartender or chef 
preparing the order. The indication "Iced Tea" as selected 

30 from a menu of the hand-held would also be presented to the 
bartender/chef, perhaps by printing and/or screen display. 
Both the literal screen capture method and the voice recorded 
message method combine the power of automatic fixed menu 
generation with the expanded flexibility to resolve opera-

35 tiona! issues that exist throughout the hospitality market with
out this innovative solution. Additionally, in certain embodi
ments, hand-writing and voice recognition technologies can 
be utilized to convert the manual operator inputs into appro
priate text messages which can be combined with the com-

40 puter generated menu options to convey the combined infor
mation to, for example, a bartender or chef. 

Similarly, hand-held devices can link the above innova
tions to individual customers at specific tables through a 
graphical user interface on the hand-held screen that assigns 

45 each customer a number within a table. For example, table 20 
might have 6 customers (1-6) and each customer has a differ
ent order, By enabling the linkage of the orders to specific 
customer positions within the table and accessible from the 
hand-held screen, the servers can easily track and link the 

50 specific orders to the specific customers. 
Manual modifications to the generated menus include 

handwritten screen captures and/or voice recorded message 
captures coupled with the standard menus and modifiers gen
erated according to standard choices. Such manual modifica
tions enable an extremely rapid and intuitive interface to 55 

enhance operations and further optimize the overall operator 
interface. This approach solves a long-standing, operational 
issue in restaurant/hotel/casino food/drink ordering when 
customers want something unusual and not anticipated and 
available through normal computerized selections. As seen in 60 

FIG. 8, the operator screen on the hand-held can capture 
handwritten information specific to a customers requests 
directly on the touch-sensitive screen of the wireless comput
ing device. This additional information can then be coupled 
with the fixed menu and modifier information generated auto- 65 

matically from the hospitality application software and the 
combined message can be sent to a restaurant point of sale 

The use of wireless handheld devices in the restaurant and 
hospitality industry is becoming increasingly pervasive as 
restaurant owners and managers become more aware of the 
benefits. With the proper wireless handheld system in place, 
restaurants can experience increased table turns from 
improved server productivity and shorter order taking and 
check paying times. Restaurants and POS companies seeking 
to provide a wireless handheld interface to their desktop
based POS systems or a Web page equivalent face several 
challenges. These challenges include building a menu using 
their existing database and transferring the menu onto hand
held devices or Web pages that will interface with servers 
wirelessly or to restaurants/customers over the internet. The 
menu generation approach of the present invention is the first 
coherent solution available to accomplish these objectives 
easily and allows one development effort to produce both the 
handheld and Web page formats, link them with the existing 
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POS systems, and thus provides a way to turn a complicated, 
time-consuming task into a simple process. 

6 

The information management and synchronous communi
cations system of the present invention features include fast 
synchronization between a central database and multiple 
handheld devices, synchronization and communication 
between a Web server and multiple handheld devices, a well
definedAPI that enables third parties such as POS companies, 
affinity program companies and internet content providers to 
fully integrate with computerized hospitality applications, 10 

real-time communication over the internet with direct con
nections or regular modem dialup connections and support 
for batch processing that can be done periodically throughout 
the day to keep multiple sites in synch with the central data-

15 
base. 

FIG. 7 is a schematic representation of a point of sale 
interface on a wireless handheld device for use in displaying 
page menus created in conformity with a preferred embodi
ment of the present invention. 

FIG. 8 is an example of a literal, hand-written screen 
according to embodiments of the present invention. 

FIG. 9 is an exemplary system diagram relating to embodi
ments of the present invention. 

DETAILED DESCRIPTION OF THE INVENTION 

Most personal computers today run under an operating 
system that provides a graphical user interface ("GUI") for 
accessing user applications. A GUI is used in the preferred 
embodiment of the present invention. Through an interface of 
windows, pull-down menus, and toolbars, GUI operating sys-

The communication module also provides a single point of 
entry for all hospitality applications, e.g., reservations, fre
quent customer ticketing, wait lists, etc. to communicate with 
one another wirelessly and over the Web. This communica
tion module is a layer that sits on top of any communication 
protocol and acts as an interface between hospitality applica
tions and the communication protocol and can be easily 
updated to work with a new communication protocol without 
modifYing the core hospitality applications. An exemplary 
system diagram of such a communications systemic relation
ship is shown in FIG. 9 and serves as an example of the power 
of the synchronization element of the invention through a 
common, linked solution. A single point of entry works to 
keep all wireless handheld devices and linked web sites in 
synch with the backoffice server applications so that the dif
ferent components are in equilibrium at any given time and an 
overall consistency is achieved. For example, a reservation 
made online can be automatically communicated to the back
office server and then synchronized with all the wireless 
handheld devices wirelessly. Similarly, changes made on any 
of the wireless handheld devices are reflected instantaneously 
on the backoffice server Web pages and the other handheld 
devices. 

BRIEF DESCRIPTION OF THE DRAWINGS 

The foregoing features and advantages of the present 
invention can be appreciated more fully from the following 
description, with references to the accompanying drawings in 
which: 

FIG. 1 is a schematic representation of a window displayed 
on a computer display screen which shows a hierarchical tree 
menu, modifier window and sub-modifier window in confor
mity with a preferred embodiment of the present invention. 

FIG. 2 is a schematic representation of a modifier dialog 
box in conformity with a preferred embodiment of the present 
invention. 

FIG. 3 is a schematic representation of a menu category 
dialog box in conformity with a preferred embodiment of the 
present invention. 

FIG. 4 is a schematic representation of a menu item dialog 
box in conformity with a preferred embodiment of the present 
invention. 

FIG. 5 is a schematic representation of a display customi
zation dialog box in conformity with a preferred embodiment 
of the present invention. 

FIG. 6 is a schematic representation of a communications 
control window in conformity with a preferred embodiment 
of the present invention. 

tems have simplified PCs and have rendered computer tech
nology more user friendly by eliminating the need to memo
rize keyboard entry sequences. In addition, GUis allow users 

20 to manipulate their data as they would physical entities. For 
example, a window can represent a file and the contents of the 
window can represent the records of the file. The window can 
be opened, closed, or set aside on a desktop as if it were an 
actual object. The records of the file can be created, deleted, 

25 modified and arranged in a drag-and-drop fashion as if they 
also were physical objects. The most common GUI operating 
systems that provide this "object-oriented" environment for 
personal computers are Microsoft Windows® systems, 
including Windows CE® for handheld wireless devices and 

30 the like. Generally, a particular application program presents 
information to a user through a window of a GUI by drawing 
images, graphics or text within the window region. The user, 
in turn, communicates with the application by "pointing" at 
graphical objects in the window with a pointer that is con-

35 trolled by a hand-operated pointing device, such as a mouse, 
or by pressing keys on a keyboard. 

The use of menus is conventional in GUis for software 
applications. Menus are typically utilized to provide end 
users of applications with available choices or processing 

40 options while using the applications. For example, in a typical 
desktop or interactive application, selection of a "file" from a 
menu bar may cause display of a context menu which pro
vides "file" options. File options can have additional subor
dinate or child options associated with them. If a file option 

45 having subordinate options is selected, the child options are 
displayed in context in a child menu or submenu proximate to 
the selected parent option. One or more of the child options 
provided in the child menu may have further subordinate 
options. Thus, such a menu system comprises cascading sets 

50 of menus which are displayable in context to show the parent/ 
child relationships between options of the context menu. A 
menu system of this type is incorporated into the preferred 
embodiment of the invention. 

The preferred embodiment of the present invention uses 
55 typical hardware elements in the form of a computer work

station, operating system and application software elements 
which configure the hardware elements for operation in 
accordance with the present invention. A typical workstation 
platform includes hardware such as a central processing unit 

60 ("CPU"), e.g., a Pentium® microprocessor, RAM, ROM, 
hard drive storage in which are stored various system and 
application programs and data used within the workstation, 
modem, display screen, keyboard, mouse and optional 
removable storage devices such as floppy drive or a CD ROM 

65 drive. The workstation hardware is configured by software 
including an operating system, e.g., Windows® 95, 98, NT or 
CE, networking software (including internet browsing soft-
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ware) and application software components. The preferred 
embodiment also encompasses a typical file server platform 
including hardware such as a CPU, e.g., Pentium® micropro
cessor, RAM, ROM, hard drive, modem, and optional remov
able storage devices, e.g., floppy or CD ROM drive. The 
server hardware is configured by software including an oper
ating system, e.g., Windows® 95, 98, NT or CE, networking 
software (including Web server software) and database soft-
ware. 

A computer workstation for use in the preferred embodi- 10 

ment also includes a GUI. As is conventional, the GUI is 
configured to present a graphical display on the display 
screen arranged to resemble a single desktop. Execution of an 
application program involves one or more user interface 

15 
objects represented by windows and icons. Typically, there 
may be several windows and icons simultaneously present on 
the desktop and displaying information that is generated by 
different applications. 

The window environment is generally part of the operating 20 

system software that includes a collection of utility programs 
for controlling the operation of the computer system. The 
computer system, in tum, interacts with application programs 
to provide higher level functionality, including a direct inter
face with the user. Specifically, the application programs 25 

make use of operating system functions by issuing task com
mands to the operating system which then performs the 
requested task. For example, an application program may 
request that the operating system display certain information 
on a window for presentation to the user. 30 

An aspect of the preferred embodiment of the information 
management and communications system of the invention is 
shown in FIG. 1. FIG. 1 shows an example of the GUI pro
vided by the operating system of the preferred embodiment of 
the present invention. With reference to FIG. 1, the preferred 35 

embodiment includes an intuitive GUI 1 from which to build 
a menu on a desktop or other computer. A hierarchical tree 
structure 2 is used to show the different relationships between 
the menu categories 3 (e.g., soups, salads, appetizers, entrees, 
deserts, etc.), menu items 4 (e.g., green salad, chicken caesar 40 

salad, etc.), menu modifiers 5 (e.g., dressing, meat tempera
ture, condiments, etc.) and menu sub-modifiers 6 (e.g., Ital
ian, French, ranch, bleu cheese, etc.). 

The procedure followed in configuring a menu on the desk
top PC and then downloading the menu configuration onto the 45 

POS interface on the handheld device in conformance with 
the preferred embodiment is as follows. 

8 
desired category and then clicking on Add Item; (3) highlight
ing the desired category, then typing Ctrl + N or ( 4) clicking on 
the Add icon on the tool bar. 

When building a menu, it should be kept in mind that the 
menu items are stored using a tree metaphor similar to how 
files are stored on a PC with folders and subfolders. The menu 
structure is similar to the Windows® File Explorer in the way 
the items are organized hierarchically. Below is an example of 
how an item may be configured: 

Menu 
>> Entrees 

>> RedMeat 
>> NY Strip 

>> -~~eg~e_ta_b_le_s ________ __ 

>> Tomato 
>> Lettuce 
Meat Temperature 

>> Medium Rare 

In the above example, Menu is the root. Entrees is a menu 
category. Red Meat is an Entree category. NY Strip is a 
modifier. Vegetable is a modifier. Meat Temperature is a 
modifier. Medium Rare is a sub-modifier of Meat Tempera-
ture. 

The steps taken in building a menu are as follows: 
1. Add Modifiers; 
2. Add Sub-Modifiers and link them to the Modifiers; 
3. Create Menu categories; 
4. Add menu items to the categories; 
5. Assign Modifiers to the menu items; 
6. Preview the menu on the POS emulator on the desktop 

PC; 
7. Download the menu database to the handheld device. 
To add modifiers, a user clicks on the inside of the Modi-

fiers window, then (1) clicks on Edit>Add Modifier; (2) 
Presses Ctrl+N; (3) right mouse clicks in the Modifiers win
dow, then clicks on Add Modifiers or ( 4) clicks on the Add 
icon from the toolbar. If a menu is being built from scratch, the 
procedure is to enter the Long Name, Short Name, Code and 
Price in the Modifier dialog box 10 shown in FIG. 2. The Long 
Name is the full descriptive name of the item. The Short Name 
is the abbreviated name that will be displayed on the handheld 
device. The Code is the numeric or alphanumeric code for the 
item. If there is an existing database, the existing database can 
be browsed and menu items retrieved from the database. 
Clicking on the Browse button will bring up the existing 

The menu configuration application is launched by click
ing on the appropriate icon on the desktop display screen. 
FIG. 1 will then be displayed. There are three windows on the 
screen shown in FIG. 1. The left window is the menu tree 7, 
also called the tree view. The top right window is the Modi
fiers window 8 and the bottom right window is the Sub
Modifiers window 9. The Sub-Modifiers window lists the 
sub-modifiers that correspond to the modifier that is selected. 
The views on the right are referred to as list views. There are 
several ways of invoking a command, including using the 
menu options; using the context menu (right mouse click); 
using the keyboard or using the toolbar icons. For example, if 
it is desired to add a category to the menu, the following four 
options are available: (1) clicking on Edit, Add Category; (2) 
right mouse clicking on Menu, then clicking on Add Cat
egory; (3) highlighting Menu, then typing Ctrl+T or (4) click
ing on the Add Category icon on the tool bar. To add an item to 
a category, the following options are available: (1) highlight
ing the category to which it is desired to add an item and then 
clicking on Edit> Add Item; (2) right mouse clicking on the 

50 database of menu items. The item to be added is then selected 
and "OK" is clicked. The fields will then be filled with the 
information from the database. Clicking on OK again will add 
the item as a modifier. To delete a modifier, the modifier is 
selected and the Delete key pressed on the keyboard. To edit 

55 a modifier, either the modifier is double clicked or the Enter 
key is pressed. 

Sub-modifiers represent the last level of modifiers that can 
be assigned to a menu tree. To add sub-modifiers, the modifier 
to which sub-modifiers are to be assigned is selected. Then, 

60 the focus is set on the sub-modifier window by clicking inside 
the Sub-Modifier window as follows: (1) clicking on 
Edit> Add Sub-Modifier; (2)pressing Ctrl+N; (3) right mouse 
clicking in the Sub-Modifiers window, then clicking on Add 
Sub-Modifiers or ( 4) clicking on the Add icon from the tool-

65 bar. If a menu is being built from scratch, the procedure is to 
enter the Long Name, Short Name, Code and Price in a 
Sub-Modifier dialog box similar to the Modifier dialog box 
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shown in FIG. 2. As with modifiers, the Long N arne is the full 
descriptive name of the item. The Short Name is the abbre
viated name that will be displayed on the handheld device. 
The Code is the numeric or alphanumeric code for the item. 

10 
menu is correctly configured before downloading it to the 
handheld device. To preview, File>Preview Database is 
clicked on or the Preview Database icon from the toolbar is 
clicked on. The handheld POS emulator on the desktop can 
then be run. If the configuration is deemed acceptable, the 
handheld device is connected to the desktop PC to ensure that 
a connection has been established; the POS application on the 
handheld device is exited and File>Download Database is 
clicked on or the Download Database icon from the toolbar is 

As before, if there is an existing database, the existing data
base can be browsed and menu items retrieved from the 
database. Clicking on the Browse button will bring up the 
existing database of menu items. The item to be added is then 
selected and OK clicked. The fields will then be filled with the 
information from the database. Clicking on 0 K again will add 
the item as a sub-modifier. To delete a sub-modifier, the 
sub-modifier is selected and the Delete key depressed on the 
keyboard. To edit a sub-modifier, either the sub-modifier is 
double clicked or the Enter key is pressed. 

10 clicked on. If there is an existing menu database on the hand
held device, the system will ask if the existing database 
should be replaced. Yes is clicked if existing database replace
ment is desired. 

A database function enables the creation of, e.g., a break-
Menu categories are created from the root. Some examples 15 fast menu, lunch menu and dinner menu and downloading 

them to a handheld device. Functions available are (1) creat
ing a new database; (2) opening an existing database; (3) 
saving a database under a different name. To access these 

of categories are Appetizers, Soups, Salads, Entrees, Des
serts, etc. The first step is to click on Menu in the menu tree 
window. Categories are added by (1) clicking on the Add 
Category icon from the toolbar; (2) clicking on Edit>Add 
Category or (3) pressing Ctrl+T. As shown in FIG. 3, Menu 20 

Category dialog box 11 then appears in which to enter the 
Long and Short names for the menu category. 

To add menu items to categories, the menu category which 

functions, File is clicked on the menu bar. 
The preferred embodiment encompasses customized lay-

out, views and fonts. To set the focus on the view it is desired 
to change, click inside the desired window. The main custom
izing dialog box is accessed by clicking on View>Customize 
View. A dialog box 13, as shown in FIG. 5, will be displayed is being built is clicked. For example, ifitems are being added 

to Appetizers, the Appetizers branch is clicked on. Then the 
Edit> Add Item is clicked on or Ctrl+N pressed. As before, if 
a menu is being built from scratch, the procedure is to enter 
the Long Name, Short Name, Code, Prep Time, Recipe and 
Price into the Menu Item dialog box 12 shown in FIG. 4. The 
Long N arne is the full descriptive name of the item. The Short 
Name is the abbreviated name that will be displayed on the 
handheld device. The Code is the numeric or alphanumeric 
code for the item. Prep Time is the time it takes to prepare the 
meal and Recipe would include preparation methods and 
ingredients that are used in the preparation of the item. If there 
is an existing database, the existing database can be browsed 
and menu items retrieved from the database. Clicking on the 
Browse button will bring up the existing database of menu 
items. The item to be added is then selected and OK is clicked. 

25 including tabs that allow the following options: selection of 
Columns to display in the list view by choosing and arranging 
the fields to display in the Modifiers and Sub-Modifiers win
dows; formatting Columns by specifying the column widths 
and justification; selecting Filter allows restricting the list to 

30 display only the items that meet certain criteria. For example, 
display of modifiers with codes between 500 and 550. Select
ing Sort allows sorting the modifiers or sub-modifiers accord
ing to any of the available fields such as Name, Code or Price. 
Selecting Style facilitates choice offont type, style, size, etc. 

35 To change the font in a particular window, click on 
View>Fonts or right mouse click in the desired window and 
then click on Fonts. To change the size of the windows, drag 
the borders of the windows to expand or contract the size of 

The fields will then be filled with the information from the 40 

database. Clicking on OK again will add the item to the 
category. 

Once the menu items have been entered, it may be desired 
to assign some modifiers to the menu items. For example, it 
may be desired to assign meat temperature to a steak order. To 45 

accomplish this, first the modifier to be assigned is selected, 
then the menu item on the tree view that is to be assigned the 
modifier is clicked on and then Edit>Assign Modifier is 
clicked on. Or, the modifier can simply be dragged and 
dropped onto the menu item to link them. A dialog box is then 50 

displayed asking if this modifier is a required modifier. If it is 
a required modifier, the display icon will be red but if it is a 
non-required modifier the display icon will be green. As many 
modifiers as are applicable can be assigned. If any changes are 
made to the modifiers, those changes will be automatically 55 

reflected throughout the menu tree. 

the windows. To change the column widths, simply drag the 
edge of the column headers to increase or decrease the col
umn widths. 

A communications control program monitors and routes 
all communications to the appropriate devices. It continu
ously monitors the wireless network access point and all other 
devices connected to the network such as pagers, remote 
devices, internet Web links and POS software. Any message 
received is decoded by the software, and then routed to the 
appropriate device. No user action is needed during operation 
of the software once the application has been launched. To 
launch the communications control module, a Wireless Traf
fic icon is clicked on the desktop PC. When the program 
loads, the screen shown in FIG. 6 appears. Messages received 
are logged in the window 14 shown in FIG. 6 with a time 
stamp. The messages are also logged to a file on the hard 
drive. This provides a mechanism to monitor all traffic across 
the network (possibly useful for troubleshooting, or mainte-
nance, but not necessary for normal operation). The program 
may be minimized so the screen is not displayed on the 
desktop, but it must be rum1ing for proper communications to 
exist between all devices on the network. 

As stated, the preferred embodiment of the present inven
tion includes the use of and compatibility with GUI technol
ogy. A drag-and-drop approach is used for organizing the tree 
structure 2 in the generated menu. Drag-and-drop is also used 

Once the modifiers have been entered, it may be desired to 
assign sub-modifiers to the modifiers items. For example, it 
may be desired to add Honey Mustard as a sub-modifier to 
Dressing. To accomplish this, first the modifier to be assigned 60 

a sub-modifier is selected, then the sub-modifier window is 
clicked on, then Edit> Add Sub Modifier is clicked on, Ctrl +N 
entered or the Add icon from the tool bar is clicked on. Or, the 
sub-modifier can simply be dragged and dropped onto the 
modifier to link them. 65 for assigning modifiers (modifiers can be dragged from the 

modifiers window 5 and dropped onto the menu item 4 for 
assigument). In-cell editing results in fast editing of items in 

When the menu has been completely configured, it can be 
previewed on a POS emulator on the desktop to verifY that the 
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building the menus. Customizable fonts enable users to 
change font types, style and size. Customizable layouts 
enable users to resize windows, change icons and display 
preferences. The inventive approach provides for fully per
sistent storage between sessions, even if a session is improp
erly or abruptly terminated. Font and the tree state (i.e., which 
nodes are expanded/collapsed) are stored between sessions. 
Layout for modifiers and sub-modifiers list views (filter, col
unms, formatting, font, etc.) are stored between sessions. The 
last database used is likewise stored between sessions. Split- 10 

ter views allow the user to see different views at the same 
time. Each view is displayed on its own section of the screen. 
Views can be resized via the keyboard or a mouse by simply 
dragging the splitter in the middle. 

An automated function is provided to import existing POS 15 

databases into the inventive menu generation system and, as 
discussed above with respect to the detailed example of how 
to use the preferred embodiment, an automated download 
procedure is provided to transfer the desktop database onto a 
handheld device and/or Web page. Also as discussed, the 20 

preferred embodiment facilitates preview of the handheld 
device or Web page version of the POS menu on the desktop 
before downloading and configuration. Customizable desk
top menu generation is contemplated, as discussed above, in 
the form of customizable fonts, colunms, layouts, etc. The 25 

inventive approach also includes templates for common 
modifiers that can be assigned to similar menu items. The 
preferred embodiment also supports multiple databases, thus 
providing for the creation and storing of different menu data
bases on handheld devices such as breakfast, lunch or dinner 30 

menus. The user can then select the appropriate database to 
reflect the time of day. 

FIG. 7 is a schematic representation of a point of sale 
interface 15 for use in displaying a page-type menu 16 created 
using the inventive menu generation approach. As can be seen 35 

from FIG. 7, the page menu is displayed in a catalogue-like 
point-and-click format whereas the master menu, FIG. 1, is 
displayed as a hierarchical tree structure. Thus, a person with 
little expertise can "page through" to complete a transaction 
with the POS interface and avoid having to review the entire 40 

menu of FIG. 1 to place an order. A PDA or Web page format 
could appear like FIG. 7 or the display could be configured for 
particular requirements since fully customizable menu gen
eration and display are contemplated. 

The POS interface on the handheld device supports pricing 45 

in the database or querying prices from the POS server. The 
POS device also can be customized with respect to "look and 
feel" for the particular version. As can be seen in FIG. 7, the 
POS interface provides for billing, status and payment with 
respect to orders. A myriad of options can be provided 50 

depending on the application. 
Advanced database functions are provided in the preferred 

embodiment of the invention, including an automated down
load process onto handheld devices and/or Web sites. In the 
preferred embodiment, the menu generation system of the 55 

present invention uses an API called ActiveX Data Objects 
("ADO") for database access. ADO is useful in a variety of 
settings. It is built on top of OLE DB and can be used to talk 
to databases and, in the future, any data source with any OLE 
DB driver. Advanced querying is supported. The database can 60 

be queried on virtually all fields. Queries can be built using 
SQL syntax for experienced users or can be created using a 
query builder which guides users through the creating pro
cess. Advanced error handling is supported. Errors occurring 
at run time can be trapped. A descriptive message is displayed 65 

to alert the user and provide error information. However, the 
application does not terminate when the errors happen. The 

12 
source code is easy to maintain and modifY, thus allowing for 
on time delivery of customized versions of the software. The 
advanced database functions produce well-designed data
bases that accommodate growth and scalability 

The inventive menu generation approach provides a solu
tion for the pervasive connectivity and computerization needs 
of the restaurant and related markets. The inventive solution 
includes automatic database management and synchroniza
tion, PDA and handheld wireless operating system integra
tion and optimization, wireless commnnications and internet 
connectivity, user interface design, and graphics design. 

In the preferred embodiment, the menu generation 
approach of the present invention uses Windows CE® as the 
operating system for the handheld devices. Windows CE® 
provides the benefits of a familiar Windows 95/98/NT® look 
and feel, built-in synchronization between handheld devices, 
internet and desktop infrastructure, compatibility with 
Microsoft Exchange®, Microsoft Office 9® and TCP/IP 
quick access to information with instant-on feature. 

Windows CE® provides a basic set of database and com
munication tools for developer use. However, interfacing 
with these tools to provide application specific results can be 
a complex task. In addition to the menu generation described 
above, a set of software libraries described herein in conform
ance with the present invention not only enhances the basic 
Windows CE® functionality by adding new features but also 
maximizes the full potential of wireless handheld computing 
devices. Such features include fast synchronization between a 
central database and multiple handheld devices, synchroni
zation and communication between a Web server and mul
tiple handheld devices, a well-definedAPI that enables third 
parties such as POS companies, affinity program companies 
and internet content providers to fully integrate with comput
erized hospitality applications, real-time communication 
over the internet with direct connections or regular modem 
dialup connections and support for batch processing that can 
be done periodically throughout the day to keep multiple sites 
in synch with the central database. 

The synchronous communications control module dis
cussed above provides a single point of entry for all hospital
ity applications to communicate with one another wirelessly 
or over the Web. This communications module is a layer that 
sits on top of any communication protocol and acts as an 
interface between hospitality applications and the communi
cation protocol. This layer can be easily updated to work with 
a new commnnication protocol without having to modify the 
core hospitality applications. The single point of entry works 
to keep all wireless handheld devices and linked Web sites in 
synch with the backoffice server (central database) so that the 
different components are in equilibrium at any given time and 
an overall consistency is achieved. For example, a reservation 
made online is automatically commnnicated to the backoffice 
server which then synchronizes with all the wireless handheld 
devices wirelessly. Similarly, changes made on any of the 
wireless handheld devices will be reflected instantaneously 
on the backoffice server and the other handheld devices. 

The software applications for performing the functions 
falling within the described invention can be written in any 
commonly used computer language. The discrete program
ming steps are commonly known and thus programming 
details are not necessary to a full description of the invention. 

A simple point-to-point wireless capability is contem
plated which permits simple digital messages to be sent from 
the wireless handheld devices to a receiver in a beeper and/or 
valet parking base-station. The POS interface of FIG. 7 is 
representative of the display on a typical wireless device used 
in conformity with the invention. A simple protocol is used to 
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acknowledge receipt of the message and thus simultaneous 
communication is not necessary, which reduces the cost of the 
wireless link. The range of the wireless link is determined by 
the characteristics of the radio transceiver. Adding a wireless 
link allows paging of beeper equipped customers directly 
from the operator interface on the wireless handheld devices 
and communication to and from various input/output trans
mitters and receivers to update the status of the order, reser
vation or other information and thus further reduce the work-
load on the operator and enable operations to proceed much 10 

faster. This link could also be hardwired or otherwise imple
mented using any two-way messaging transport. 

14 
item desired. The information entered by the user is transmit
ted to the server. The user may select multiple items in this 
manner and then enter a credit card number to pay for the 
purchases. The retailer processes the transaction and ships the 
order to the customer. As can be appreciated, ordering mer
chandise can also be done from menus. The generation of 
menus of items or merchandise for sale over the internet is 
readily accomplished by the menu generation approach of the 
present invention. 

Searching for items that the user is interested in purchasing 
is insufficient in prior merchandising systems. Database man
agement programs use index searching to facilitate rapid 
searching of large amounts of data. The creator of the data
base may instruct the program to use specified fields in the 

A further aspect of the invention is the use of the menus 
generated in accordance with the described technique to place 
orders from wireless remote handheld devices or from remote 
locations through the internet. The World Wide Web is a 
distributed hypermedia computer system that uses the inter
net to facilitate global hypermedia communication using 
specified protocols. One such protocol is the Hypertext Trans

15 database as indexed or key fields. The program locates all 
terms in the database that appear in the indexed fields and 
stores them in an index table. Each entry in the index table 
includes a term and corresponding pointer to the location in 
the database where the term is found. If a user initiates a 

20 search for a term that is present in the index table, the program 
can locate the instances of that term in the database with 

fer Protocol ("HTTP"), which facilitates communication of 
hypertext. Hypertext is the combination of information and 
links to other information. In the context of the Web, hyper
text is defined by the Hypertext Mark-up Language 
("HTML"). The links or hyperlinks in a HTML document 
reference the locations of resources on the Web, such as other 
HTML documents. Another language used in creating docu
ments for use on the Worldwide Web, to display on computer 
screens, or to create speech style sheets for use in, e.g., tele
phones, is the Extensible Mark-Up Language ("XML"). 
XML is a "metalanguage", i.e., a language for describing 30 

languages which was developed to eliminate the restrictions 
ofHTML. 

exceptional speed. Users who are familiar with the particular 
database they are searching will generally know which fields 
are indexed and will know the format of the data in those 

25 fields. For example, a user of a database containing the inven
tory of a bookstore may know that users can search for the 
names of authors ofbooks and that a user who wishes to do so 
should enter the author's last name first. A user having such 

The Web is a client-server system. The HTML documents 
are stored on Web server computers, typically in a hierarchi

knowledge will therefore be able to search efficiently. Users 
of electronic merchandising systems, however, are generally 
end -consumers who have no know ledge of a merchant's data-
base. If, as is very likely, such a user initiates a search for a 
term that is not present in the index table, the program must 
sequentially search through all records in the database. 

cal fashion with the root document being referred to as the 
home page. The client specifies a HTML document or other 
source on the server by transmitting a Uniform Resource 
Locator ("URL") which specifies the protocol to use, e.g., 
HTTP, the path to the server directory in which the resource is 
located, and filename of the resource. Users retrieve the docu
ments via client computers. The software running on the 
user's client computer that enables the user to view HTML 
documents on the computer's video monitor and enter selec
tions using the computer's keyboard and mouse is known as 

35 Sequential records are typically linked by pointers. Using 
pointers in this manner is very demanding on server 
resources, resulting not only in an exceptionally slow search, 
but also creating a bottleneck for other processes that the 
server may be executing. The menu generation approach of 

40 the present invention can be used to create customized menus 
from a database that includes every item of merchandise the 
vendor has for sale. In this manner, customers can scan the 
generated menu much more readily than they could view the 
entire database and the necessity of having familiarity with 

45 the database is eliminated as well, reducing the need for a browser. The browser typically includes a window in which 
the user may type a URL. A user may cause a URL to be 
transmitted by typing it in the designated window on the 
browser or by maneuvering the cursor to a position on the 
displayed document that corresponds to a hyperlink to a 
resource and actuating the mouse button. The latter method is 50 

commonly referred to simply as "clicking on the hot-spot" or 
"clicking on the hyperlink". The hyperlink methodology is 
contemplated for use in accordance with the preferred 
embodiment to transmit orders via the internet. 

Web server application software exists that enables a user 55 

to shop for and order merchandise. Such systems are some
times referred to as electronic merchandising systems or vir
tual storefronts. Systems that enable a user to choose among 
several retailers' goods are sometimes referred to as elec
tronic malls. An electronic retailer's or electronic mall opera- 60 

tor's Web server provides HTML forms that include images 
and descriptions of merchandise. The user may convention
ally search for an item by entering a key word search query in 
a box on a form. When a user selects an item, the server may 
provide a linked form that describes that item in further detail. 65 

The user may also conventionally enter ordering information 
into boxes on the form, such as the type and quantity of the 

resource intensive pointers. 
While the preferred embodiment of the invention is for the 

generation of restaurant menus and the like, the broad scope 
of the invention is far greater. For example, menus generated 
in accordance with the invention can be used in the desktop 
computing environment in association with the operating sys
tem or application programs. One such use is to facilitate the 
creation of user personalized file structures for general desk
top use. Another use is to facilitate the location of customized 
menus from master menus for use in association with appli
cation software to make the execution of the application soft
ware more efficient by, e.g., eliminating the necessity of que
rying or checking every tree branch in the master menu file 
structure in response to user input or other criteria and to 
create handheld/PDA compatible versions of the software. 

While the preferred embodiment of the invention includes 
the selection of items from a master menu wherein the master 
menu is displayed using a graphical user interface, it is to be 
appreciated that any means for displaying the master menu to 
the user and generating another menu in response to and 
comprised of the selections made is encompassed by the 
contemplated invention. The invention encompasses the 
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selection of nontextual symbols, characters, icons and the 
like, in addition to text, from a hierarchical tree menu or the 
like for generation of another menu comprised of such items. 

It is also within the scope of the invention to generate 
menus automatically in response to predetermined criteria. 
For example, in the restaurant menu generation embodiment, 
a modified menu can be generated to comply with a particular 
specification or group of criteria such as, e.g., "dinner", "low 
cholesterol", "low fat", "fish", "chicken", or "vegetarian". In 
this embodiment, only items from the master menu that sat- 10 

isfy specified parameters will be included in the generated 
menu. The selection process could involve selection of master 
menu items based on tags or identifiers associated with the 
items or by checking every master menu item against a dic
tionary of items acceptable for inclusion in the modified 15 

menu. It should also be appreciated that the invention encom
passes any combination of automatic and manual user selec
tion of the items comprising the generated menu. For 
example, a user might specifY criteria which would further 
control automatic selection or the user could manually select 20 

some items with automatic selection of others. The menu 
generation aspect of the invention is equally applicable to 
table-based, drive-thru, internet, telephone, wireless or other 
modes of customer order entry, as is the synchronous com-
munications aspect of the invention. 25 

The inventive concept encompasses the generation of a 
menu in any context known to those skilled in the art where an 
objective is to facilitate display of the menu so as to enable 
selection of items from that menu. The restaurant menu gen
eration embodiment is but one example of a use for the 30 

inventive concept. Likewise, displaying menus generated in 
accordance with the invention on PDAs and Web pages to 
facilitate remote ordering are but a few examples of ways in 
which such a menu might be used in practice. Any display and 
transmission means known to those skilled in the art is 35 

equally usable with respect to menus generated in accordance 
with the claimed invention. 

In the more general situation, menus can be generated in 
accordance with the present invention in a variety of situa
tions. For example, the usable file structure for a particular 40 

data processing application can be dictated by the user or an 
application program prior to or during the execution of the 
application program. Efficiencies with respect to computa
tional speed and equipment, e.g., storage and processor, 
usage can thus be achieved along with the facilitation of 45 

display of the generated menu. 
While the best mode for carrying out the preferred embodi

ment of the invention has been illustrated and described in 
detail, those familiar with the art to which the invention 
relates will recognize various alternative designs and embodi- 50 

ments which fall within the spirit of practicing the invention. 
The appended claims are intended to cover all those changes 
and modifications falling within the true spirit and scope of 
the present invention. 

That which is claimed is: 55 

1. An information management and real time synchronous 
communications system for configuring and transmitting 
hospitality menus comprising: 

a. a central processing unit, 
b. a data storage device connected to said central process- 60 

ing unit, 

16 
menu is capable of being configured for display to facili
tate user operations in at least one window of said first 
graphical user interface as cascaded sets of linked 
graphical user interface screens, and 

e. menu configuration software enabled to generate a pro
grammed handheld menu configuration from said mas
ter menu for wireless transmission to and programmed 
for display on a wireless handheld computing device, 
said programmed handheld menu configuration com
prising at least menu categories, menu items and modi
fiers and wherein the menu configuration software is 
enabled to generate said programmed handheld menu 
configuration by utilizing parameters from the master 
menu file structure defining at least the menu categories, 
menu items and modifiers of the master menu such that 
at least the menu categories, menu items and modifiers 
comprising the progrmed handheld menu configura
tion are synchronized in real time with analogous infor
mation comprising the master menu, 

wherein the menu configuration software is further enabled 
to generate the progrmed handheld menu configura
tion in conformity with a customized display layout 
unique to the wireless handheld computing device to 
facilitate user operations with and display of the pro
grammed handheld menu configuration on the display 
screen of a handheld graphical user interface integral 
with the wireless handheld computing device, wherein 
said customized display layout is compatible with the 
displayable size of the handheld graphical user interface 
wherein the programmed handheld menu configuration 
is configured by the menu configuration software for 
display as programmed cascaded sets oflinked graphi
cal user interface screens appropriate for the customized 
display layout of the wireless handheld computing 
device, wherein said programmed cascaded sets of 
linked graphical user interface screens for display of the 
handheld menu configuration are configured differently 
from the cascaded sets oflinked graphical user interface 
screens for display of the master menu on said first 
graphical user interface, and 

wherein the system is enabled for real time synchronous 
communications to and from the wireless handheld 
computing device utilizing the programmed handheld 
menu configuration including the capability of real time 
synchronous transmission of the programmed handheld 
menu configuration to the wireless handheld computing 
device and real time synchronous transmissions of 
selections made from the handheld menu configuration 
on the wireless handheld computing device, and 

wherein the system is further enabled to automatically 
format the programmed handheld menu configuration 
for display as cascaded sets of linked graphical user 
interface screens appropriate for a customized display 
layout of at least two different wireless handheld com-
puting device display sizes in the same connected sys
tem, and 

wherein a cascaded set of linked graphical user interface 
screens for a wireless handheld computing device in the 
system includes a different number of user interface 
screens from at least one other wireless handheld com
puting device in the system. 

c. an operating system including a first graphical user inter
face, 

d. a master menu including at least menu categories, menu 
items and modifiers, wherein said master menu is 
capable of being stored on said data storage device pur
suant to a master menu file structure and said master 

2. The information management and synchronous commu
nications system in accordance with claim 1, wherein the 
system is further enabled by a communications systemic rela-

65 tionship providing a common, linked system comprising: 
a) A Wireless Hub Application; 
b) A Web Hub Application; 



US 8,146,077 B2 
17 

c) Linked Databases between two or more different Hos
pitality Applications; and 

d) A Communications Setup Application. 
3. The information management andrea! time synchronous 

communications system in accordance with claim 1 wherein 
the information from the POS database is automatically 
imported into the system. 

4. The information management and real time synchronous 
communications system in accordance with claim 1, wherein 
the said Hospitality Applications include at least reservations 10 

applications. 
5. The information management and real time synchronous 

communications system in accordance with claim 1, wherein 
the said Hospitality Applications include at least a Ticketing 
applications. 15 

6. The information management and real time synchronous 
communications system in accordance with claim 1 in which 
the wireless handheld computing device is a smart phone. 

7. The information management andrea! time synchronous 
communications system in accordance with claim 1, further 20 

enabled to facilitate and complete payment processing 
directly from the wireless handheld computing device includ
ing: a) Billing; b) Status and c) Payment Information. 

8. The information management and real time synchronous 
communications system in accordance with claim 1, wherein 25 

one or more of the layout, views or fonts of the programmed 
handheld menu configuration are created in conformity with 
the display screen parameters of the wireless handheld com
puting device and wherein the system is enabled to generate a 
view of the programmed handheld menu configuration for 30 

user preview from the central computing unit and which 
facilitates a further user manual modification prior to the 
transmissions of the programmed handheld menu configura
tion to the wireless handheld computing device. 

9. An information management and real time synchronous 35 

communications system for configuring and transmitting 
hospitality menus comprising: 

a) a central processing unit; 
b) a data storage device connected to said central process-

ing unit; 40 

c) an operating system including a first graphical user 
interface, said operating system configured to intemp
erate with the central processing unit, the data storage 
device and application software; 

d) a master menu including menu categories and menu 45 

items, wherein said master menu is capable of being 
stored on said data storage device pursuant to a master 
menu file structure and said master menu is capable of 
being configured for display to facilitate user operations 
in at least one window of said first graphical user inter- 50 

face as cascaded sets of linked graphical user interface 
screens; and 

e) a modifier menu capable of being stored on said data 
storage device, and menu configuration software 
enabled to automatically generate a programmed hand- 55 

held menu configuration from said master menu for 
display on a wireless handheld computing device, said 
programmed handheld menu configuration comprising 
at least menu categories, menu items and modifiers and 
wherein the menu configuration software is enabled to 60 

generate said programmed handheld menu configura
tion by utilizing parameters from the master menu file 
structure defining at least the categories and items of the 
master menu and modifiers from the modifier menu at 
least the menu categories, menu items and modifiers 65 

comprising the progrmed handheld menu configura
tion are synchronized in real time with analogous infor-

18 
mation compnsmg the master and modifier menus 
wherein the menu configuration software is further 
enabled to generate the programmed handheld menu 
configuration in conformity with a customized display 
layout unique to the wireless handheld computing 
device to facilitate user operations with and display of 
the programmed handheld menu configuration on the 
display screen of a handheld graphical user interface 
integral with the wireless handheld computing device, 
wherein said customized display layout is compatible 
with the displayable size of the handheld graphical user 
interface, 

wherein the programmed handheld menu configuration is 
configured by the menu configuration software for dis
play as cascaded sets of linked graphical user interface 
screens appropriate for the customized display layout of 
the wireless handheld computing device, wherein said 
cascaded sets of linked graphical user interface screens 
for display of the programmed handheld menu configu
ration are configured differently from the cascaded sets 
of related graphical user interface screens for display of 
the master menu on said first graphical user interface, 
and 

wherein the system is enabled for real time synchronous 
communications to and from the wireless handheld 
computing device utilizing the programmed handheld 
menu configuration including the capability of real time 
synchronous transmission of at least the menu catego
ries, menu items and modifiers comprising the pro
grammed handheld menu configuration to the wireless 
handheld computing device and real time synchronous 
transmissions of selections made from the handheld 
menu configuration on the wireless handheld computing 
device, and 

wherein the system is further enabled to automatically 
format the programmed handheld menu configuration 
for display as cascaded sets of linked graphical user 
interface screens appropriate for a customized display 
layout of at least two different wireless handheld com
puting device display sizes in the same connected sys
tem, and 

wherein a cascaded set of linked graphical user interface 
screens for a wireless handheld computing device in the 
system includes a different number of user interface 
screens from at least one other wireless handheld com
puting device in the system. 

10. The information management and real time synchro
nous communications system in accordance with claim 9, 
further including a communications systemic relationship 
comprising: 

a) A Wireless Hub Application; 
b) A Web Hub Application; 
c) Linked Databases Between two or more different Hos

pitality Applications; and 
d) A Communications Setup Application. 
11. The information management and real time synchro

nous communications system in accordance with claim 9, 
wherein at least two different hospitality software applica
tions are integrated between and with one another. 

12. The information management and real time synchro
nous communications system in accordance with claim 9, 
wherein the system enables automatic importation of the POS 
database information into the system. 

13. An information management and real time synchro
nous communications system for use with wireless handheld 
computing devices and the internet comprising: 
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a) a master database connected in said system and config
ured to store hospitality application information pursu
ant to a master database file structure· 

b) at least one wireless handheld comp~ting device con
nected in said system and configured to display said 
hospitality application information; 

c) at least one web server connected in said system; 
d) at least one web page connected in said system and 

configured to display said hospitality application infor
mation; and e) real time communications control soft- 10 

ware enabled to link and synchronize hospitality appli
cation information simultaneously between the master 
database, wireless handheld computing device, web 
server and web page, 

wherein the communications control software is enabled to 
15 

utilize parameters from the master database file structure 
to synchronize the hospitality application information in 
real time between the master database, at least one wire
less handheld computing device, at least one web server 
and at least one web page such that substantially the 

20 

same information comprising the hospitality application 
information is capable of being displayed on the wire
less handheld computing device, at least one web page 
and other display screens of the synchronized system, 
such that the hospitality application information is syn-

25 

chronized between any connected users, 
wherein the communications control software is enabled to 

act as a real time interface between the elements of the 
syst.em and any applicable communications protocol, 

wherem the communications control software is enabled to 
30 

automatically and simultaneously configure the hospi
tality application information for display on both the 
wireless handheld computing device and the web page in 
confo~mity with a customized display layout unique to 
the Wireless handheld computing device or the web 

35 

~age, ~herein.said customized display layout is compat
Ible w1th the d1splayable size of the handheld computing 
device display screen or the web page, and 

wherein the communications control software is further 
enabled to automatically format a programmed hand-

40 

held configuration for display as cascaded sets oflinked 

20 
graphical user interface screens appropriate for a cus
tomized display layout of at least two different wireless 
handheld computing device display sizes in the same 
connected system, and 

wherein a cascaded set of linked graphical user interface 
screens for a wireless handheld computing device in the 
system includes a different number of user interface 
screens from at least one other wireless handheld com
puting device in the system, and 

wherein the system is enabled for real time synchronous 
transmission of the configured hospitality application 
information to the wireless handheld computing device, 
the web server and the web page and real time synchro
nous transmissions of inputs responding to the config
ured hospitality application information from the wire
less handheld computing device, or the web server or the 
web page. 

14. The information management and real time synchro
nous communications system in accordance with claim 13 
furthe~ ~ncluding a . communications systemic relationshi~ 
compnsmg: a) A W1reless Hub Application; b) A Web Hub 
Application; c) Linked Databases Between two or more dif
ferent Hospitality Applications; and d) A Communications 
Setup Application. 

15. The information management and real time synchro
~ous communications system of claim 13, wherein the system 
IS enabled to automatically import the information from the 
POS (point of sale) database into the system. 

16. The information management and real time synchro
nous communications system of claim 13, wherein at least 
two different hospitality applications are integrated between 
and with one another. 

17. The information management and real time synchro
nous communications system in accordance with claim 13 
wherein the hospitality application information also include~ 
the completion of payment processing. 

18. The information management and real time synchro
nous communications system in accordance claim 13 
:-"herein the configured wireless handheld computing devic~ 
1s a smart phone. 

* * * * * 




